
[[ID DIGITAL RESEARCH~ 



Documentation by: Jim Rogers 
Joe Guzaitis 



COPYRIGHT 

Copyright © 1986 Digital Research Inc. All rights reserved. No part of this 

publication may be reproduced, transmitted, transcribed, stored in a retrieval 

system, or translated into any language or computer language, in any form or 

by any means, electronic, mechanical, magnetic, optical, chemical, manual, or 

otherwise, without the prior written permission of Digital Research Inc., 

60 Garden Court, P.O. Box DRI, Monterey, California 93942. 

DISCLAIMER 

DIGITAL RESEARCH INC. MAKES NO REPRESENTATIONS OR WARRANTIES WITH 

RESPECT TO THE CONTENTS HEREOF AND SPECIFICALLY DISCLAIMS ANY IMPLIED 

WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. 

Further, Digital Research Inc. reserves the right to revise this publication and 

to make changes from time to time in the content hereof without obligation of 

Digital Research Inc. to notify any person of such revision or changes. 

NOTICE TO USER 

This manual should not be construed as any representation or warranty with 

respect to the software named herein. Occasionally changes or variations 

exist in the software that are not reflected in the manual. Generally, if 

such changes or variations are known to exist and to affect the product 

significantly, a release note or README file accompanies the manual and 

distribution disk(s}. In that event, be sure to read the release note or 

README file before using the product. 

TRADEMARKS 

Digital Research and its logo are registered trademarks of Digital Research Inc. 

GEM, GEM Desktop, GEM Draw, GEM Draw Plus, GEM Paint and the GEM Logo 

are trademarks of Digital Research Inc. 

Second Edition: September 1986 



Foreword 
Welcome to GEM Draw ™ Plus -- the electronic drawing package for 
your personal computer. 

This guide explains. concepts and procedures to help you use GEM Draw 
Plus. It is divided into the following sections: 

• Section 1 describes preliminary steps you must complete before using 
GEM Draw Plus on your computer. It also shows how to start the 
program . 

• Section 2 takes you on a brief tour of the GEM Draw Plus screen. It 
explains how, why, and when to use the various drawing tools and 
discusses concepts that help you use the software. 

• Section 3 is a tutorial that walks you through the basic steps of using 
GEM Draw Plus. 

• Sections 4 and 5 contain reference information. They explain in detail 
the menus, commands, and picture elements you use with GEM Draw 
Plus. 

In addition to the GEM Draw Plus software, your distribution disks 
contain pictures created by Digital Research® using GEM Draw Plus. You 
can use these images in other pictures you create. You can also 
examine the pictures to see how you might achieve similar effects. 

The artwork in this book was created using GEM Draw Plus and GEM 
Paint™. 

This version of GEM Draw Plus is designed for use with the version 2.0 
or higher GEM Desktop. 
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SECTION 1 

Getting Started 
This section is designed to help you get started using GEM Draw Plus. 
It is divided into two topics. 

The first shows you how to install GEM Draw Plus on your computer. 
The installation process organizes the GEM Draw Plus program on your 
floppy disks or hard disk. It is a simple procedure and only requires a 
few minutes to complete. You will not be able to use GEM Draw Plus 
until you install it. 

The second shows how to start GEM Draw Plus on your computer. 

Please read and follow the instructions in this section before you use 
GEM Draw Plus. 

PRELIMINARY STEPS 

Before you do anything else, make copies of the disks you received with 
the GEM Draw Plus package. Fill out two labels as shown below and 
attach them to the appropriate copies: 

GEM Draw Plus Application Disk BACKUP COpy 
GEM Draw Plus Library Disk BACKUP COpy 

Store your original disks in a safe place and use your copies to 
complete the installation procedures. 

Your DOS manual explains how to format and copy floppy disks using 
the DISKCOPY command. (Do not use COPY.) Refer to it now if you need 
to. If you have not read your GEM __ ~esk!QJ1 ™ guide and completed the 
introductory section, you should do that also before continuing. Many of 
the concepts and procedures you use in GEM Draw Plus are explained 
there. You can also use the GEM Desktop to copy disks. 
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Installing GEM Draw Plus GEM Draw Plus 

INSTALLING GEM DRAW PLUS 

The steps required to install GEM Draw Plus on floppy disks are slightly 
different from those required to install it on a hard disk. Follow the 
instructions that apply to your particular installation. 

Installing on Floppy Disks 

You need three blank floppy disks to complete these procedures. 
Format the disks, fill out labels as shown below, and attach them to the 
disks. These will become your regular working copies of GEM Draw 
Plus. 

GEM Draw Plus APPLICATION Disk -- Working Copy 
GEM Draw Plus PICTURES Disk -- Working Copy 
GEM Draw Plus LIBRARY Disk -- Working Copy 

Set the disks aside, and then do the following: 

1. Start the GEM Desktop. 

2. Remove the GEM DESKTOP Disk from drive A and replace it with the 
disk you have labeled "GEM Draw Plus Application Disk BACKUP 
COpy." 

3. Double-click on the drive A icon to open its window. If the window 
is already open, press the Esc key to update the window with the 
contents of the disk now in that drive. 

4. Locate the icon labeled INSTALL.APP in the window. 

IttSTAll.APP 

5. Double-click on the INSTALL.APP icon to start the installation 
program. 
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GEM Draw Plus Installing GEM Draw Plus 

6. Dialogs appear on your screen asking you for information and telling 
you when to change disks. Follow the instructions until you see a 
dialog telling you the installation is complete. GEM Draw Plus is 
ready to use from your floppy disks. 

Skip ahead to "Results of Installing GEM Draw Plus" on page 1-4. 

Installing on a Hard Disk 

This process creates two folders (named GEMAPPS and LIBRARY) in your 
hard disk root directory and copies the GEM Draw Plus files into them. 
If you have an earlier version of GEM Draw installed and want to save it, 
copy the files DRAW.APP and DRAW.RSC from the existing GEMAPPS 
folder to a different folder before installing GEM Draw Plus. 

1. Start the GEM Desktop. 

2. Insert "GEM Draw Plus Application Disk BACKUP COPY" in drive A. 

3. Double-click on the drive A icon to open its directory in this 
window. If the window already contains the root directory for Drive 
A, press the Esc key to update the window with the contents of the 
disk now in that drive. 

4. Locate the icon labeled INSTALL.APP in the window. 

[IT] 
INSTALL.APP 

5. Double-click on the INSTALL.APP icon to start that program. 

6. Dialogs appear on your screen asking you for information and telling 
you when to change disks. Follow the instructions until you see a 
dialog telling you the installation is complete. GEM Draw Plus is 
ready to use from your hard disk. 
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RESULTS OF INSTALLING GEM DRAW PLUS 

The figure below shows what your hard disk or "working copy" floppy 
disks contain after you install GEM Draw Plus. 
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GEM Draw Plus Results of Installing GEM Draw Plus 

When you install GEM Draw Plus, DRAW.APP is placed in a folder named 
GEMAPPS in the root directory of either your "GEM Draw Plus 
APPLICATION Disk" or your hard disk. The PICTURES and LIBRARY folders 
are created to store pictures. 

~ ~ 
DRAW.APP 

U 
PICTURES 

o 
LIBRARY 

The GEM Draw Plus software program. 

Resource files (DRAW.RSC not shown) contain 
icons and other objects you see on your screen 
when you are using GEM Draw Plus. 

The PICTURES folder is for the pictures you 
create with GEM Draw Plus, so it is initially 
empty. Unless you instruct otherwise, GEM Draw 
Plus stores your pictures in this folder when you 
save them on disk. 

The LIBRARY folder contains pictures provided 
with GEM Draw Plus. You can use these pictures 
(or parts of them) in other pictures you create. 
You'll learn how to do this in later sections of 
this guide. 

If you installed GEM Draw Plus on floppy disks, the PICTURES folder is 
in the root directory of the disk labeled "GEM Draw Plus PICTURES Disk" 
and the LIBRARY folder is in the root directory of the disk labeled "GEM 
Draw Plus LIBRARY Disk." If you installed GEM Draw Plus on a hard disk, 
all folders are in the root directory. 
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STARTING GEM DRAW PLUS 

To start GEM Draw Plus, follow these steps: 

1. Start the GEM Desktop if it isn't already running. 

2. If you're running GEM Draw Plus from floppy disks, place your GEM 
Draw Plus APPLICATION Disk Working Copy in drive A and your GEM 
Draw Plus PICTURES Disk in drive B. 

3. Double-click on the disk icon where your GEMAPPS folder is stored 
to open its directory window. 

If you're running from floppy disks, the GEMAPPS folder is on the 
disk in drive A. If you're running from a hard disk, the GEMAPPS 
folder is on that drive (normally drive C). 

4. Open the GEMAPPS folder by double-clicking on its icon. 

5. Locate the DRAW.APP icon inside the directory window. 

DRAW.APP 

6. Double-click on the DRAW.APP icon to start GEM Draw Plus. 

Note: Running GEM Draw Plus from Drive A may bring up a "Can't write 
to disk ... " alert on your screen. Click on CANCEL to proceed. 

Another way you can start GEM Draw Plus is described on the following 
page. 
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GEM Draw Plus Starting GEM Draw Plus 

Starting with a Specific Picture 

There may be times when you want to start GEM Draw Plus and have a 
specific picture appear immediately on your screen. This section 
explains how to start GEM Draw Plus this way. 

All GEM Draw Plus pictures are represented by an 
icon like the one shown at the left. The name of 
your picture appears in place of "EXAMPLE" 

EXAMPLE.GEM 

1. With the GEM Desktop on your screen, locate the PICTURES folder. 

2. Double-click on the PICTURES folder to display its contents. 

3. Locate the icon for the picture you want to use. 

4. Double-click on the picture's icon. GEM Draw Plus starts with that 
picture on your screen. 

Note: If you run out of data space while working on a picture, save your 
picture immediately. This may free up some data space for you to 
continue working. 

End of Section 1 
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GEM Draw Plus Screen 
and Concepts 

SECTION 2 

This section explains what you see on the screen when using GEM Draw 
Plus and discusses other concepts that help you use the program. You 
might want to try some of the features of GEM Draw Plus right away. 
If, while drawing, you want to clear the screen and start over, display 
the File Menu and choose the New or the Abandon command. Click on 
Yes when prompted to confirm. The screen will be cleared of all 
figures. 

GEM DRAW PLUS SCREEN 

The GEM Draw Plus screen and some of the features of the GEM Draw 
Plus working area are shown on the next page. 

This section describes these features so that you will be prepared for 
the tutorial in Section 3. The GEM Draw Plus screen contains many of 
the same components you see on the GEM Desktop screen, such as: 

• Menu Bar 
• Close Box 
• Title Bar 
• Full Box 
• Scroll Bars, Sliders, and Arrows 

These components work much the same as on the GEM Desktop. 
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_------------- Window --_____________ __ 

Toolkit 
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GEM Draw Plus Title Bar 

MULTIPLE WINDOWS 

With GEM Draw Plus you can have two windows open on your screen at 
the same time and copy all or part of a picture from one window to 
another. This is a powerful function of GEM Draw Plus. You will learn 
how to use it when you read about the Open command in Section 4. 

The "active window" is the one in which you are working. When two 
windows are open on your screen, only one can be active. (The folder 
and picture names are dimmed in the title bar of the inactive window.) 
To make a window active, place the pointer inside the window and click. 

SIZE BOX 

TITLE BAR 

You can change the size of the active window by 
dragging the size box. When you drag, you see a 
shadowy outline. When the outline is the size 
and shape you want for your window, release the 
mouse button. Resizing windows is something 
you do when you have two windows open at the 
same time and are copying between them. It is 
also useful when using desk accessories, since 
they can end up "behind" windows. 

Inside the title bar is folder (directory) information and your picture's 
name and type. See your GEM Desktop guide or operating system 
manual for information about folder or path names. 

You can also use the title bar to move a window on your screen. Place 
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Close Box GEM Draw Plus 

the pointer inside the title bar and drag the window to the position you 
want. 

Moving windows is something you often do when you have two 
windows on the screen at the same time, especially when copying 
between them. 

Picture Name and Type 

The picture name reads "untitled" until you save your picture on disk 
and give it a name. Thereafter, the name you provide and the GEM type 
appear in the title bar along with the name of the folder the picture has 
been saved in. 

Appendix B describes picture names and types. 

CLOSE BOX 

2-4 

Click on the close box to close your active 
window and remove it from the screen. The close 
box works the same way as the Close command 
(see page 4-14). 



GEM Draw Plus Drawing Surface 

MENU BAR 

The menu bar contains the titles of the GEM Draw Plus menus. These 
menus contain commands you use to create or manipulate your 
pictures. Although the menu titles are different from those on the GEM 
Desktop, the menus work the same way. Section 4 describes the GEM 
Draw Plus menus and commands. 

DRAWING SURFACE 

The drawing surface is your work area, the part of the screen where you 
create pictures. 

The drawing surface is like a sheet of drawing paper. There are many 
ways you can control the size, format, and your view of the drawing 
surface. You wi" learn about these functions later. 

If you use a drawing surface larger than 8 112 X 11", your output will be 
spread over several pages. If you want to keep your output within an 8 
1/2 x 11" drawing surface, choose the "Best Fit" printer option in the 
Preferences Menu of the OUTPUT Application. 
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Toolkit GEM Draw Plus 

TOOLKIT 

At the left of the GEM Draw Plus work area is the toolkit. The tool 
icons are labeled in the figure below. 

Sketch Circle 

Arc Polygon 

Rounded Line 
Rectangle 

Text Rectangle 

Zoomer-------W~~~~ 

Panner ----- ------- Pointer 

Ruler -----1m ..111----- Grid 

GEM Draw Plus Toolkit 

When you click on a tool icon in the toolkit, GEM Draw Plus highlights it 
to indicate your current selection. 
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GEM Draw Plus The Tools 

l·HE TOOLS 

The GEM Draw Plus tools are icons showing the type of picture element 
that each can create. They are described as they are presented in the 
toolkit, left to right, top to bottom. 

Sketch 

Circle 

Use this icon to draw free hand on the drawing 
surface. The width and style of line created is 
determined by the current setting in the line 
Menu. You can also specify the line end style 
(square, rounded, or arrow) in the End Styles 
dialog in the line Menu. 

Use this icon to create circles and ellipses. The 
thickness and stvle of the line is determined by 
settings in the line Menu.· If a pattern has been 
selected in the Pattern Menu, the figure is 
automatically filled with that pattern when it is 
completed. 
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The Tools 

Arc 

Polygon 

Rounded Rectangle 
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GEM Draw Plus 

Use this icon to create figures that are one 
quarter of a circle (or ellipse). The line and line 
end styles are determined by the selections in the 
Line Menu. If a pattern has been selected, a "pie 
slice" is created; if not, only an arc. 

Use this icon to create many-sided objects with 
straight sides. The style and thickness of the 
sides are determined by the settings in the Line 
Menu. If a pattern is selected, the object is filled 
with that pattern when completed. 

Use this icon to create rectangles (or squares) 
with rounded corners. When completed, each is 
filled with the selected pattern, if any, from the 
Pattern Menu. The rectangle's borders will be the 
current selection in the Line Menu. 



GEM Draw Plus 

Line 

\ 
Text 

TEXT 

Rectangle 

The Tools 

Use this icon to create straight lines on the 
drawing surface. The kind of line and its end 
style is determined by the current settings in the 
Line Menu. A polygon created with this tool 
cannot be filled. 

Use this icon to add text to your figures. The 
Type Menu controls the style, size, and font of 
the text created. Placement is controlled by 
locating the text cursor where the text is to 
appear. 

Use this icon to create squares or rectangles on 
the drawing surface. As they are completed, they 
are filled with the currently selected pattern, if 
any. The rectangle's outline is the current 
selection in the Line Menu. 
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Elements GEM Draw Plus 

ELEMENTS 

Elements such as rectangles, lines, polygons, 'circles, and text are the 
basic building blocks you use to create pictures with GEM Draw Plus. 
The icons in the toolkit are the "tools" that you use to create these 
elements. This section describes general rules that apply to picture 
elements. See Section 5 for detailed descriptions of each element. 

When you draw with GEM Draw Plus, you can "layer" the picture 
elements one atop another. To understand this concept, think of the 
elements you use to draw pictures as paper cutouts. For example, you 
might draw a circle and then lay a rectangle on top of the circle. Even 
though the rectangle might completely hide the circle from view, the 
circle is still part of the picture, as the illustration below demonstrates. 

Note: Pictures that are to be sent to a plotter should not have "layered" 
elements. Plotters will overprint any such areas in a picture. 

Layered Elements 
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GEM Draw Plus Elements 

Current Element 

The term "current element" refers to the element or elements GEM Draw 
Plus acts upon when you do something. For example, if your picture 
contains three different elements and you choose the Delete command 
from the Modify menu, GEM Draw Plus deletes only the current element. 

Element Extents 

GEM Draw Plus identifies the current element by placing "extents" 
around it. Extents are the small black boxes connected by lines that 
surround the element, as the figure shows. 

--

-
Element Extents 

When you add a new element to a picture, it is automatically the current 
element. You can also make existing picture elements current using the 
various methods described next. 

Selecting Elements 

To make an element current, go to the toolkit and 
click on the pointer icon (described later in this 
section). Then, place the pointer on the element 
or anywhere within its extents and click. 
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Elements GEM Draw Plus 

You can make any number of elements all current using one of the 
following methods: 

Shift-click Click on the pOinter icon. Hold down the Shift 
key as you click on all the elements you want to 
make current. 

Rubber-Rectangle Click on the pointer. Place the pointer at one 
corner of the group of elements you want to 
select and drag in any direction. When you drag, 
a "rubber rectangle" appears. When the rubber 
rectangle encloses all of the elements you want 
to select, release the mouse button. 

Select all Command Display the Modify Menu and choose the Select 
all command. GEM Draw Plus makes all elements 
in your picture current. 

Selecting Through Layers 

Because you can layer elements directly on top of one another, you 
sometimes need a way to select through layers to make a specific 
layered element current. To do this, hold down the Ctrl key while you 
click on an element. (This technique is also helpful when nesting 
elements. See "Grouping Elements" later in this section.) 

De-selecting Elements 

If you don't want any elements in your picture to be current, click on 
the pOinter icon, place the pOinter in an open area of your drawing 
surface, and click again. 

If multiple elements are current and you want to de-select one or more 
of them, click on the pOinter, then hold down the Shift key while you 
click on the element or elements you want to de-select. 
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GEM Draw Plus Elements 

Moving Elements 

To move the current element or elements to another location, select the 
element(s). Click on the pointer icon and then place the pOinter well 
within the element's extents. As you drag the pointer, an outline of the 
extents follows. Release the mouse button when the extents are where 
you want the element. 

Grouping Elements 

Because pictures often consist of many elements, you sometimes need 
to combine elements so you can treat them as a single entity. 

For example, suppose you draw a picture of the American flag and want 
to scale it down to a smaller size. If you form the flag's elements into a 
group, you can quickly reduce the scale of the drawing. Without 
grouping, you would have to rescale and reposition each element in the 
flag individually, a tedious and time-consuming task. 

Grouping is a powerful and useful feature of GEM Draw Plus. However, 
any action you take on a group affects every element within it. For 
example, if you change the color of the flag in the preceding example 
after forming it into a group, GEM Draw Plus changes the color of every 
element in the group. Consequently, you would end up with a colored 
rectangle rather than a picture of the American flag. 

To work around this situation, GEM Draw Plus gives you a way to break 
a group after forming it. For example, to change the color of the stripes 
in your flag picture, you can break the group, change the colors of the 
individual stripes, and then reform the original group. 

Grouping allows you to size multiple elements while maintaining their 
proportions; it also allows you to move or copy elements while 
maintaining their relative positions. For more information about groups, 
see the Make group and Break group descriptions in Section 4. 
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Scaling Elements 

You can change an element's size or proportions by using the eight 
small black boxes located on the extents. You can only rescale one 
element at a time, however. 

To change the scale of a current element, begin by clicking on the 
pointer icon. Then place the painter on one of the black boxes and 
drag. The extents stretch or contract like a rubber rectangle. The rubber 
rectangle marks the area within which GEM Draw Plus will rescale the 
element when you release the mouse button. 

Use the black boxes on the corners for two-dimensional scaling, that is, 
to change both the height and width of an element in one operation. 
Use the boxes at the midpoint of the sides to scale in one dimension, 
that is, to change either the height or width of the element, but not 
both. The figure shows examples of one- and two-dimensional scaling. 

Note: You cannot rescale text using the methods described here. See 
"Point Sizes" on page 4-23 for details. 
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I 

One 
Dimension 

Width Only 

Two 

Dimensions 

H e i g h t and Wid t h 

Examples of Element Scaling 

Elements 
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Elements 

Zoomer 

GEM Draw Plus 

The zoomer provides a way to magnify a portion 
of your picture. This does not change the size or 
proportions of its elements, it only makes them 
appear larger. 

Working in the magnified state is an excellent way to add fine detail and 
small elements to your pictures. 

The zoomer contains boxes labeled Full, 1/2, 1, 2, 4, and 8. Click on one 
of these boxes to change magnification states. Double-click on a box to 
automatically invoke the panner (described on page 2-17). 

Each successive state magnifies your picture by a factor of two -
every element appears twice as large (in each dimension) as in the 
previous state. For example, if your picture is in the 1 state and you 
click on 2, you only see one quarter of your picture on the drawing 
surface, but every element appears twice as large (in height and width.) 
Similarly, the 1/2 state shows an overall view larger than 1 shows. The 
Full box shows you the entire page reduced to fit on your screen. The 
figure below shows the approximate area of your picture you see in 
each magnification state. (Not all views are available for all page sizes.) 

Full 1 / 2 2 4 8 

Relative Magnification States 
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GEM Draw Plus Selector Icons 

True Picture State 

Click on zoomer state 1 to display your picture in its "true" state. In the 
true state, text and line elements appear in their correct proportions. 
(For example, 72 pt. text is actually 1 inch high. See Point Sizes on 
page 4-23.) 

SELECTOR ICONS 

The key things you do with the selector icons are the following: 

• select an area of your picture where you want to work 

• make an element or elements current 

• change the attributes used to draw new or existing elements 

Panner 

Use the panner to display different parts of your 
picture on the drawing surface. 

When you click on the panner icon, you see a full view of your picture. 
You also see the panner rectangle, as the figure on the next page 
shows. The panner rectangle encloses the area of your picture you 
were viewing befo[~ you clicked on the panner icon. 
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[] 
t 

Panner Rectangle 

Panner Rectangle 

Drag the panner rectangle so it encloses the area of your picture you 
want to see on your drawing surface. When you release the mouse 
button, that area appears inside your window. 

The panner works like the scroll bars and sliders except that the panner 
gives you a full view of the picture and lets you go directly where you 
want to go with one movement. 

You automatically invoke the panner when you double-click on a 
magnification state in the zoomer. 
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GEM Draw Plus 

Pointer 

Selector Icons 

The pointer icon is the tool you use to make 
elements current. It puts the pointer into "select 
mode". Two important ways you use it are 
described below. 

Selecting the attributes used to draw picture elements. 

GEM Draw Plus draws all elements with the line, pattern, color and type 
attributes currently set. Use the pointer to choose from the menus 
those attributes you want GEM Draw Plus to use. 

Keep the following important concepts in mind when you use the 
pointer: 

• You change element attributes by choosing those you want from the 
Type, Line, Pattern, and Color menus and the line End Styles dialog. 

• If any elements are current when you choose an attribute from a 
menu or dialog, that attribute applies only to the current element or 
elements. 

• If NO element or elements are current when you choose an attribute 
from a menu or dialog, your choice applies to all elements you draw 
from then on. Small markers indicate the current choices in each 
menu and in the line End Styles dialog. 

Changing picture elements AFTER drawing them. 

For example, you can move an element, group it with others, delete it 
from your picture, change its dimensions or attributes, and so forth. Use 
the pointer to choose an element and then make these or other changes 
to it. 
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DRAWING AIDS 

GEM Draw Plus has several aids to help you create drawings more 
precise than would normally be possible on a plain drawing surface. 

Grid 

If the drawing surface is like a sheet of drawing paper, the grid (the 
dots on your drawing surface) transforms this drawing paper into graph 
paper. 

The grid helps you align the different parts (elements) of your picture. 
These dots never appear when you reproduce a picture on a printer, 
plotter, screen, tablet, or camera. 

The grid is optional. Click once on the grid icon to turn the grid on or 
off. Double-click on the grid icon to display a dialog box that lets you 
set the ruler size (how close the dots are to each other) Click once on 
the adjacent ruler icon to turn the ruler on or off. 

Auto Grid 

Auto grid is another optional feature. You turn the Auto grid on and off 
by choosing the Auto grid On/Off command from the Page menu. 

When the Auto grid is on, GEM Draw Plus "snaps" your figure to the 
nearest grid pOint on the drawing surface. This ensures precise 
alignment of picture elements when you need it. (Note: The grid does 
not have to be visible for the Auto grid feature to take effect.) 

When Auto grid is turned off, GEM Draw Plus places picture elements at 
the exact spot you select on the drawing surface. 

When using the Auto Grid feature of GEM Draw Plus, you should use 
only the top four line styles in the Line Menu during the preliminary 
phase of your drawing. When you finish altering your design, you can 
replace thin lines with thicker ones where appropriate. If you use the 
thicker lines at first, it may be difficult to move them around the screen 
as you complete your design. 
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GEM Draw Plus 

Ruler Icon 

1 2 3 
I I I 

1-

2-

Grid Icon 

Drawing Aids 

Click on this icon to display (or hide) horizontal 
and vertical rulers on your drawing surface. 
Double-click on the icon to invoke the Page size 
command. 

Click on this icon to display (or hide) the grid 
points on your drawing surface. Remember, 
displaying or hiding the grid points has no effect 
on the Auto grid described earlier. Double-click 
on the icon to invoke the Ruler spacing 
command. 

End of Section 2 
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SECTION 3 

Tutorial 
This section teaches the basics of using GEM Draw Plus. Because GEM 
Draw Plus is such a versatile and powerful tool, the tutorial is limited to 
teaching you fundamental concepts and procedures; it does not teach 
you the art of drawing. 

• While using the tutorial, you can start over at any time by choosing 
the New command from the File Menu. 

• If you want to remove an element from your picture, choose the 
Delete command from the Modify Menu while the element is current. 

• To stop GEM Draw Plus and return to the GEM Desktop, choose the 
Quit command from the File Menu. 

After you have used GEM Draw Plus for a while and feel comfortable 
with the tools and commands, you may want to examine the pictures 
provided in the GEM Draw Plus library. Take the pictures apart by 
ungrouping them to see how the various elements were combined to 
create images and effects. If you do this, however, you may want to 
make copies of the library pictures before you make changes to them. 

The best way to learn GEM Draw Plus is to experiment. Try new things. 
Let your imagination be your guide. You'll find the learning experience 
fun, and the whole process ultimately rewarding. 

Note: If you're using a graphics tablet in place of a mouse as your 
pointing device, be sure to read Appendix 0 before you begin the 
tutorial. 
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Starting GEM Draw Plus GEM Draw Plus 

STARTING GEM DRAW PLUS 

Start GEM Draw Plus according to the instructions in Section 1. 

Here is the design you'll create with this tutorial. 

Big Sale 

PENCILS 
2{l(} /01 $/. tN} 

Objective of Tutorial 
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GEM Draw Plus Draw Pencil Eraser 

DRAW PENCIL ERASER 

The first element we will draw is an eraser for the top of the upright 
pencil. Follow these steps: 

1. Click on the rounded rectangle in the toolkit. 

2. Move the cross hair onto the drawing surface near the top left. 

3. Drag 3 units down and 3 to the right. (Recall that dragging means 
hold down the button while moving the mouse.) When you drag, a 
"rubber rectangle" previews the shape and size of the rounded 
rectangle you are drawing. When the rubber rectangle is 3 grid units 
wide by 3 units high, ~elease the mouse button. The screen should 
now look like the one below. 

D 

Draw Pencil Eraser 
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Select Eraser's· Pattern GEM Draw Plus 

SELECT ERASER'S PATTERN 

To select the eraser's pattern {to give it some texture), follow these 
steps: 

1. Move the pointer up to the menu bar and touch the word Pattern. 
The Pattern Menu appears. 

2. Move the pointer through the menu to highlight and select (click on) 
the 50% grey pattern. The screen should now look liJ<e the one 
below. 

Select Eraser's Pattern 

3-4 



GEM Draw Plus Draw Eraser Holder 

DRAW ERASER HOLDER 

1. Click on the rectangle in the toolkit. 

2. Move the crosshair onto the drawing surface and draw a rectangle 3 
grid units wide by 1 unit high (overlapping the bottom of the eraser) 
like the one below. (The drawing action is the same you used to 
draw the rounded rectangle for the eraser.) 

Draw Eraser Holder 
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Select Eraser Holder's Pattern GEM Draw Plus 

SELECT ERASER HOLDER'S PATTERN 

Select the eraser holder's pattern the same way you did with the eraser. 
Here are the steps again: 

1. Display the Pattern Menu. 

2. Select the pattern you want to use. Use the one shown in the figure 
below, or anyone you like. 

Select Eraser Holder's Pattern 
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GEM Draw Plus Draw Pencil Barrel 

DRAW PENCIL BARREL 

The pencil barrel consists of three separate but similar rectangles. 

If the rectangle is still highlighted in the toolkit, you don't have to select 
it again. 

Starting at the bottom left corner of the eraser holder, draw a rectangle 
1 grid unit wide by 7 units high, like the one below. 

Draw Pencil Barrel 
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Select Patterns and Align Elements GEM Draw Plus 

MAKE COPIES OF RECTANGLE 

Now make two copies of the rectangle. 

1. Choose the Make copy command from the Modify Menu. This makes 
the first copy. 

2. Hold down the Alt key (on the keyboard) while you type the letter C. 
This makes the second copy. 

Note that both techniques make a copy of the current element. You 
now have the three rectangles you need to form the pencil barrel. 

SELECT PATTERNS AND ALIGN ELEMENTS 

Look at the figure on the next page and then do the following steps. 

1. Choose the solid black pattern from the Pattern Menu. 

2. Click on the pointer icon in the toolkit. 

3. Place the pOinter inside the solid black rectangle's extents and drag 
the rectangle up two grid units. 

4. Click on the first f..Q.QY of the rectangle to make it current. 

5. Place the pointer inside the extents and drag the rectangle up one 
grid unit. 

6. Click on the first (leftmost) rectangle in the pencil barrel to make it 
current. 

7. Choose the 50% grey pattern from the Pattern Menu. 
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GEM Draw Plus Select Patterns and Align Elements 

The Pencil Barrel 
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Draw the Pencil Point GEM Draw Plus 

DRAW THE PENCil POINT 

Use two lines and one polygon to form the pencil point. Follow these 
steps to draw the lines: 

1. Choose the Ruler spacing command from the Page Menu. When the 
dialog appears, click on the 1/8 button and then on the OK button. 

Note that there are now twice as many grid points on the drawing 
surface and they are half as far apart. You take this step so you can 
locate the tip of the pencil point at the exact center of the pencil 
barrel. With the ruler spacing set at 1/4", you couldn't have done 
that. 

2. Click on the line icon in the toolkit. 

3. Place the cross hair at the bottom left corner of the pencil barrel. 
Drag it three grid units (3/8") to the right and then straight down 
seven grid units (1 "). Release the mouse button to draw the first side 
of the pencil point. 

4. Draw the other side of the pencil point in a similar manner. 

The picture should now look like the one on the next page. 
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GEM Draw Plus Draw the Pencil Point 

Pencil Point 
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Draw the Pencil Lead GEM Draw Plus 

DRAW THE PENCIL LEAD 

It is easier to draw the lead for the pencil point while in a magnified 
state. Here's how to magnify the picture: 

1. Double-click on the 4 in the zoomer. You see your picture in full 
view and you also see the panner rectangle. 

2. Place the pOinter inside the panner rectangle and drag it to surround 
the tip of the pencil pOint, if it doesn't do so already. When you 
release the mouse button, the screen should look like the one below. 
(If your view of the drawing surface isn't satisfactory, click on the 
panner in the toolkit and repeat this step.) 

Magnified View of Pencil Point 
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GEM Draw Plus Draw a Polygon for the Pencil Lead 

DRAW A POLYGON FOR THE PENCIL LEAD 

Look at the figure on the following page. It shows the polygon (in this 
case a triangle) you will draw by following the steps below. 

1. Choose the Auto grid Off command from the Page Menu. 

(You must turn off the Auto grid or you won't be able to draw the 
polygon in the required shape.) 

2. Click on the Polygon icon in the toolkit. 

3. Place the cross hair at the tip of the pencil paint and click. This 
marks the beginning point for the polygon. 

4. To form the first side of the polygon, move the cross hair about half 
way up the line forming the left side of the pencil point and click 
again. 

(If you click at the wrong point while drawing a polygon, press the 
Backspace key to back up to any previous point, and resume drawing 
from there.) 

5. Move the cross hair straight to the right until it intersects the line 
forming the right side of the pencil point. Click again. 

6. Return the cross hair to the tip of the pencil point and double-click. 
(You must double-click to stop drawing a polygon.) The polygon, an 
inverted triangle, is complete. 

7. Choose the Auto grid On command from the Page Menu to turn this 
feature on again. 
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Draw a Polygon for the Pencil lead GEM Draw Plus 

Drawing the Pencil Lead 
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GEM Draw Plus Select the Lead's Pattern 

SELECT THE LEAD'S PATTERN 

Choose the solid black pattern from the Pattern Menu to make the 
pencil lead look more realistic. 

Selecting the Lead's Pattern 
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Group and Copy Pencil GEM Draw Plus 

ZOOM OUT TO TRUE STATE 

You can now return to the true state to see all of the pencil. Here's 
how: 

1. Click on the 1 in the zoomer. Recall that this tells GEM Draw Plus to 
show a picture in the true state. 

2. Click on the panner in the toolkit. 

3. Drag the panner rectangle so the pencil is fully inside and at the left 
edge. When you release the mouse button, you see all of your 
pencil on the left side of the drawing surface. 

GROUP AND COPY PENCIL 

The next step is to make the pencil elements into a group and then 
create a copy. 

1. Choose the Select all command from the Modify Menu. Extents 
appear around every element in the pencil. 

2. Choose the Make group command from the Alignment Menu. A 
single extent now encloses the pencil. 

3. Choose the Make copy command from the Modify Menu. GEM Draw 
Plus makes a copy of the pencil, and extents now appear around the 
copy. 

The screen should look like the illustration on the next page. 
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GEM Draw Plus Group and Copy Pencil 

Making a Copy of Your Pencil 
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REPOSITION AND ALIGN PENCILS 

As you complete the steps below, part of the pencil may disappear off 
the edge of the drawing surface. This is normal, so don't be alarmed if it 
happens. 

1. Choose the Rotate command from the Modify Menu. The second 
pencil rotates counterclockwise 90 degrees. 

2. Repeat the preceding step two more times to rotate the pencil 
counterclockwise a total of 270 degrees. 

3. If the pointer icon is not highlighted in the toolkit, click on it now. 

4. Place the pOinter inside the pencil's extents and drag it until the left 
end of the pencil is two grid squares to the right of the vertical 
pencil. 

5. Choose the Select all command from the Modify Menu. Both pencils 
are now current elements. 

6. Choose the Align bottom command from the Alignment Menu. 

The screen should look like the illustration on the next page. 
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GEM Draw Plus Reposition and Align Pencils 

Aligning the Pencils 
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Enter Text GEM Draw Plus 

ENTER TEXT 

1. Click on the TEXT icon in the toolkit. 

2. Place the cross hair three grid units to the right and two units below 
the top of the vertical pencil. Click the mouse button and move the 
cross hair to see the text cursor, a vertical bar. 

3. Type the three lines of text shown below. When you reach the end 
of a line, press Enter four times for spacing between lines. If you 
make a typing error, use the Backspace or Del key to erase individual 
characters. Use the Esc key to erase all characters to the left of the 
cursor. 

Big Sale 

PENCILS 

200 for $1.00 

The picture should look like the illustration on the opposite page. 
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GEM Draw Plus Enter Text 

Big Sale : 

PENCILS· 

200 for $1 ;00 

Entering the Text 
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Change Type Style and Size GEM Draw Plus 

CHANGE TYPE STYLE AND SIZE 

1. If the pointer icon is not highlighted in the toolkit, click on it now. 

2. Place the pointer on "Big Sale" and click. 

3. Choose the Bold option from the Type Menu. 

4. Click on "PENCILS". 

5. Display the Type Menu two more times: the first time, choose the 
Bold option, the second time choose the 36 point option. 

6. Select "200 for $1.00" and change it to Italic. 

The picture is nearly complete and should look like the one below. 

Big Sale 

PENCILS 

--I ... 
Changing Type Style and Size 
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GEM Draw Plus Align Text Elements 

ALIGN TEXT ELEMENTS 

1. If the pointer icon is not highlighted in the toolkit, click on it now. 

2. Place the pointer above and to the left of the "Big Sale" text element 
and drag down and to the right. When the Nrubber rectangle" 
encloses all three text elements, release the mouse button. Extents 
appear around the text elements. 

(If you didn't get all three text elements, repeat this step and leave a 
wider margin around the elements.) 

3. Choose the Align center command from the Alignment Menu. 

Your design is now complete and should look like the one on the 
following page. Click on the grid icon in the toolkit to see the picture 
without the grid points. De-select the text to see it without extents. 

If you want to save the design you created, click on the Save as 
command in the File Menu. The Item Selector will come on the screen. 
As you type in the name of your picture, it will appear in the space 
labeled ·SelectionN

• (Use the Backspace key to edit the pitture name.) 
When you are ready to save the picture to disk, click on the OK button. 

To learn more about saving pictures, refer to the description of the Save 
as command. 
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Big Sale 

PENCILS 
L>tl{l fOf $1. {1(J 

When you're ready to stop the tutorial and return to the GEM Desktop, 
choose the Quit command from the File Menu. 

End of Section 3 
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SECTION 4 

GEM Draw Plus Menus 
and Commands 
You'll find a picture of each GEM Draw Plus menu in the following 
'pages with a brief description of its commands or options. When a 
command needs a more detailed description, a page reference shows 
:where to find the additional information. 

Setting and Saving Preferences 

Note the triangular markers in the Type, Line, Pattern, and Color menus. 
They mark the current choice in each menu. When you draw picture 
elements, GEM Draw Plus uses these choices for the elements' 
attributes. The markers move when you select an attribute option while 
there are no selected elements in your picture. (This same concept 
applies in the line End styles dialog described on page 4-25.) 

You can save the settings (such as page size, ruler spacing, type style 
and size, pattern, etc.) and have them preset as defaults whenever you 
start GEM Draw Plus. To do this, select Save Preferences in the Page 
Menu. The triangular markers will now point to the new type, line, and 
pattern selections when you restart GEM Draw Plus. (To restore the 
original settings, delete the file called DRAW.lNF.) 

Keyboard Shortcuts 

Note also the letters and symbols at the right side of many of the 
menus. These represent keyboard alternatives for entering commands. 
Pressing certain combinations of keys is the same as clicking on 
commands in a menu. The diamond shape (.) represents the Alt Key; 
the caret (") indicates the Ctrl key. These must be held down while the 
key indicated next to the symbol, is pressed. 

For instance, instead of choosing the Delete command in the Modify 
Menu, press Alt-D to delete an element you have selected. Similarly, 
instead of clicki'ng on the Abandon command in the File Menu, press 
Ctrl-A to abandon a picture. In the Page Menu, you can display the 
Page size dialog by simply pressing the F2 function key. 
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These shortcuts are only available when no menus are displayed. Also, 
w~en desktop accessories (such as the Calculator) are on the screen, 
these shortcuts are unavailable. 

Dialogs 

When a menu command is followed by three dots, as in Save as ... (File 
Menu) or End Styles ... (Line Menu), choosing the command displays a 
dialog presenting options. Select an option by clicking on it. You put 
your selections into effect by clicking on OK. You are usually given the 
choice to cancel the dialog and return to where you were. 

End Styles 

~- ~-
III ~ - -OK I CANCEL I 

Sample Dialog 
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FILE MENU 

Clears the active window so you 

can start a new picture. If a 

IUa ~ window is not open, places a new 

I 
New AW one on the screen. [Ctrl-W]. 

Open... AD 
__________________ Selects an existing picture for you 

Close AC 
Save AU 
Save as... AM 
Abandon AA 

To Output AU 
Quit AQ 

to work on [Ctrl-O] (page 4-10). 

Closes the active window. Also saves 

the picture on disk if you made 

changes to it [Ctrl-C] (page 4-14). 

Saves the picture in the active window 

under the name shown in the 

window's title bar [Ctrl-V] (page 4-14). 

Names a picture and saves it on 

dis,k [Ctrl-M] (page 4-15). 

Abandons changes made to a picture 

since the last time saved. The 

original picture stays in the window 

[Ctrl-A). 

Starts GEM Output so you can send 

one or more pictures to a printer, 

plotter, screen, or camera. See 

"GEM OutputH in the 

GEM Desktop guide [Ctrl-U). 

Stops GEM Draw Plus [Ctrl-OJ. 
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Page Menu 

PAGE MENU 

Auto grid Off +G 

----------------------Page size... F2 
Ruler spacing... F4 

----------------------Shortcuts... F1 
Save preferences +V 

4-4 

GEM Draw Plus 

Alternately turns the Auto grid off 

and on [Alt-G] (page 2-20). 

Displays a dialog you can use to 

specify a size and format· for a 

picture [Function Key 2] (page 4-15). 

Displays a dialog you can use to set the 

1------ unit of measure in the drawing surface 

rulers [Function Key 4] (page 4-15). 

Displays a dialog explaining the shortcut 

methods available in GEM Draw Plus. 

(Function Key 1] Also see Appendix C. 

Saves the current settings so they 

will be preset when you next use 

GEM Draw Plus (Alt-V]. 



GEM Draw Plus Modify Menu 

MODIFY MENU 

Deletes the current element or elements 

./ from a picture [Alt-DJ. 

"'~·i1II'iiiI~L ______ --../ Restores the last element (or elements) 
Delete 
Undelete 

+D 
+U 

Make copy +C 
Select all +S 

~ deleted from a picture [Alt-U). 

Creates a copy of the current element 

1----'-__ or elements.· The copy becomes the 

~ "top layer" in the picture [AIt-C). 

~ Displays the extents for all elements in 

a picture and makes every element 

c'urrent [Alt-5] (page 2-12). 

Rotates an element 90 degrees counter-

__ ... _ .•.•.••............ __ ....•.............. ~CIOCkwise [Alt-R) (page 4-171-

Rotate +R Turns the current element 180 degrees 

Flip horizontal +Z on its horizontal axis [Alt-Z] 

Fli vertical +T ~ (page 4-18). 

~ Turns the current element 180 degrees 

on its vertical axis [Alt-T] 

(page 4-18). 
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ALIGNMENT MENU 

Align[llent 
Put in front +F 
Put in back +1< 

GEM Draw Plus 

Moves the current element to the top 

layer in a picture [Alt-F] (page 4-20). 

Moves the current element to the 

botto~ .Iayer in a picture [Alt-K] 

(page 4-21). 

Groups current elements so you can 

treat them as one element [Alt-M] 

_____ .• __ •.....•.•.•... _ ...•... / (page 4-211. 

Make group +M Breaks a group so that each element 

Break group +B can be selected individually [Alt-B] 

......................................... (page 4-21). 

Align left +H 
Align center +1 
Align right +J 
Align top +Y 
Align l1liddle +L 
Align bottom +N 

Page center +P 
Even spacing +E 

4-6 

Aligns current elements at designated 

boundaries: (page 4-22) 

left [AIt-H]. 

Center [Alt-I]. 

Right [Alt-J]. 

Top [Alt-Y]. 

Middle [Alt-l]. 

Bottom [Alt-N]. 

Centers current element(s) on page 

[Alt-P] (page 4-22). 

Provides equal vertical distance 

between the current elements [Alt-E] 

(page 4-23). 
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TYPE MENU 

... Nor(llal 
Bold 
Italic 
Underline 

.............. tlttlttlttlt 

7 point 
18 point 

... 14 po;i,nt 
28 point 
28 point. 
36 point 
72 point 

tit tit tit tit tit tit tit tit tit tit tit 

... Swiss 
Dutch 

-

Type Menu 

Chooses a type style for the selected 

type font. The choice of fonts 

is listed at the bottom of the menu. 

You can combine different type styles. 

The text point size determines the 

size of the individual characters 

in a text element (page 4-23) . 

Chooses a type font for your text 

elements (page 4-24). 
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line Menu 

LINE MENU 

~------------
1/32" 

-----1/16" 
-----3/32" 

1/8" 

1===5/32" 3/16" 
1/4" 

GEM Draw Plus 

1------ Chooses a line style or line width for 

elements in your picture (page 4-24). 

Displays a dialog so you can specify 

End styles... F6 1------- how the ends of lines should look 
~------~----------~ 

[Function Key 6] (page 4-25). 
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GEM Draw Plus 

PATTERN MENU 

COLOR MENU 

DRAW MENU 

DRAW Menu 

See page 4-25 for a description 

of the patterns in this menu. 

See page 4-26 for a description 

of the colors and color codes 

in this menu. 

Displays information about GEM Draw 

_.iiMlL-------, ___________ and the percent of "drawing space" 

Draw info... available (page 4-28) . 

............................................. 

Calculator 
Clock 
Accessory 3 
Accessory 4 
Accessory 5 
Accessory 6 

lists desk accessories available 

on your computer. You start one by 

choosing it from this menu. 

NOTE: If you do not have sufficient 

Random Access Memory (RAM), your desk 

accessories do not appear in the DRAW 

Menu and cannot run. . 
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FilE MENU COMMANDS 

Open Command 

Use the Open command to do the following: 

• Bring an existing picture into the GEM Draw Plus work area. 
• Place a second picture in a second window on the screen. 

The Item Selector appears when you choose this command. (Instructions 
for using the Item Selector are in Appendix A.) Use the Item Selector to 
select the picture you want GEM Draw Plus to display on the screen. 

If you have not made any changes to the current window, or if you have 
saved any changes you have made, GEM Draw Plus replaces the current 
picture with the new one you selected. 

If you have unsaved changes in the current window, GEM Draw Plus 
automatically opens a second window to display the picture you 
selected. If you want to be sure this picture is placed in the current 
window, choose the New command before choosing Open. 

~_~LI}~_MuJtiple WindQws 

When two windows are open on the screen at the same time, you can 
copy all or part of either picture between the two windows, space 
permitting. If the picture you are trying to copy is too big (or complex) 
for the window that is to receive it, an alert box appears. 

This multi-window capability is the way to copy all or part of a picture 
from the GEM Draw Plus Library (or any other GEM Draw Plus picture) 
into one you are creating. Following is a step-by-step example 
explaining how to include a picture of a forklift (from your GEM Draw 
Plus Library) in a report cover titled "Equipment Reports". A sample of 
the report cover appears on the next page. 
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Equipment Reports 

Sample Report Cover 
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If you wish to complete the steps in the following example, you must 
use the Item Selector. See Appendix A for instructions. 

1. Choose the New command from the File Menu. This clears the 
drawing surface in the active window so you can start a new 
picture. Note that the picture name and type in the title bar reads 
"untitled". 

2. Click on the TEXT icon in the toolkit. 

3. Move the pointer onto the drawing surface near the top left and 
click. Move the cross hair to see the text cursor, a vertical bar. 

4. Type "Equipment Reports" for the report title. 

5. Click on the pointer icon and then on the "Equipment Reports" text 
element to make it current. 

6. Display the Type Menu twice. The first time, choose the 36 point 
option; the second time, choose the Bold option. The size of the 
characters in the title appear significantly larger and in boldface. 

7. Choose the Page center command from the Alignment Menu to 
center the title between the left and right margins. 

8. Click on the word Full in the zoomer to see a full view of the 
picture. (In many cases, it is easier to work with multiple pictures in 
the full state.) 

9. Use the size box to reduce the size of your window so it occupies 
approximately the left half of the screen. 

10. If you are running GEM Draw Plus from floppy disks, remove the 
PICTURES disk from drive B and replace it with the LIBRARY disk. 

11. Choose the Open command from the File Menu (the Item Selector 
appears. 

12. Use the Item Selector to open the LIBRARY folder and display its 
contents in the directory window. 
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13. Double-click on "FORKLlFT.GEM". The Item Selector disappears from 
the screen and, after a moment, a second window opens, displaying 
the picture of the forklift. The newly opened window is the active 
one. 

14. Click on "Full" in the Zoomer. If necessary, reposition the windows 
so you can see both pictures on the screen at the same time, as 
illustrated on the following page. 

15. Click on the pointer icon in the active window. Place the pointer on 
the forklift picture and click again. Extents appear around the forklift. 

16. Drag the forklift picture to the "untitled" window. When you drag, an 
outline of the forklift's extents moves with the pointer. When the 
pointer (a hand) is well inside the boundaries of the "untitled" 
window, release the mouse button. Once the forklift is part of your 
report cover, you can rescale, move, or change it any way you wish. 
Therefore, it doesn't really matter where you place it initially. 

17. Click on the close box in the FORKLlFT.GEM window. GEM Draw Plus 
closes the window and removes it from the screen. After closing the 
FORKLlFT.GEM window, GEM Draw Plus makes the remaining window 
active. 

18. If you are running GEM Draw Plus from floppy disks, remove the 
LIBRARY disk from drive B and replace it with the PICTURES disk. 

19. Choose the Save as command from the File Menu. 

20. When the Item Selector appears, click on the close box in the 
directory window until you reach the root directory. Click on the 
PICTURES folder to open it and display its contents in the directory 
window. 

21. Type "RPTCOVER" and press Enter. GEM Draw Plus stores your 
report cover in the PICTURES folder under the name RPTCOVER.GEM. 
Your report cover is finished. 
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Equipment Reports 

Multiple Windows 

Close Command 

This command removes the active window from the screen. If you made 
any changes to the drawing surface in the window, GEM Draw Plus asks 
if you want to save the picture before closing the window. 

The Close command and the window's close box (described in Section 
2) work exactly the same way. 

Save Command 

The Save command stores the picture in the active window under its 
existing name, as shown in the window's title bar. The picture remains 
in the window and you can continue working on it if you wish. 

If the picture doesn't have a name, the Save command is dimmed in the 
menu. (Use the Save as command to store a new picture and give it a 
name.) 
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Use the Save command often while working on your pictures. This 
ensures that you won't lose your work in the event of a power failure, 
computer malfunction, or other error. 

Save as Command 

Use the Save as command in the following situations: 

• the first time you save a new picture on disk and want to give it a 
name 

• when you want to save a revised version of a picture under a 
different name. The original and revised pictures are both available on 
disk under their individual names. 

When you click on this command, the Item Selector appears. Type in a 
name for the picture and click on OK. The picture is then saved. After 
you save the picture, it remains in your window. 

PAGE MENU COMMANDS 

Ruler spacing ... Command 

Use this command to set the unit of measure in your drawing surface 
rulers. Recall that you turn the rulers on and off by clicking on the ruler 
icon in the toolkit (see page 2-21). 

The units of measure are either centimeters or inches, depending on 
options you choose with the Page size command, described next. 

Page size Command 

Use this command to control your picture's layout, paper size, and 
border width. 

You see the dialog shown on the next page when you choose this 
command. Explanations of the layout, paper size, and border options 
follow. 
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PAGE SIZE 

Layout: I portrait I I landscape I 

Un its: I inches I I cent imeters I 

Paper: Iletter (8.5x11)1 Ilegal (8.5x13) I ldouble (11x17) I 
Border: []]] IT]] IT]] 

OK I I Cancel I 

Page Size Dialog 

The next figure illustrates Portrait and Landscape layouts. 
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If you change the layout of an existing picture, you may find that the 
new layout has cut off some elements that were visible in the original 
layout. You should choose your layout carefully before you begin 
drawing your picture. 

Paper 

You can choose from the sizes shown in the dialog. Sizes other than 8.5 
x 11 are printed in four sections that must be cut and pasted together. 

You can also choose whether you want the unit of measure to be 
inches or centimeters. Your choice also determines the following: 

• the options you see in the dialog when you choose the Ruler spacing 
command described earlier in this section 

• the units of measure you see in the Line Menu 

Border 

Select one of the sizes to set a border width for the four sides of your 
picture. You cannot draw in the area you set aside for the border, so 
GEM Draw Plus doesn't show it on your screen. 

MODIFY MENU COMMANDS 

Rotate Command 

The figure below shows the effect of using the Rotate command on a 
polygon three successive times. Each time the command is used, it 
rotates the polygon gO-degrees counterclockwise. Note, however, that 
the pattern inside the polygon does not rotate. 
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Rotate Command 

Flip horizontal/Flip vertical Commands 

The Flip horizontal and Flip vertical commands allow you to change 
whether a figure faces left or right, top or bottom. These commands 
have no effect on circles, rectangles, or rounded rectangles, (unless they 
are grouped) because these figures look the same when flipped. 

Also, you cannot flip a text element. However, if you flip a group that 
contains one or more text elements, GEM Draw Plus realigns the text 
within the group to retain correct spacing. 
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< Left-to-Right > 

Flip horizontal 

11 
Top-to-Bottom 

II 

Flip vertical 
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ALIGNMENT MENU COMMANDS 

Put in front Command 

As described earlier in this guide, you create GEM Draw Plus pictures by 
"layering" elements. That is, each new element you draw becomes the 
top layer in your picture. 

Put in front changes the order in which elements are layered. It makes 
the current element the most recent one drawn; that is, it becomes the 
element on the top layer of your picture. 

The figure below shows the effect of the Put in front command. In the 
illustration, the circle is the current element. vVhen it is put in front, it 
appears in front of the rectangle. 
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Put in back Command 

This command is the opposite of Put in front. It makes the current 
element the first one drawn; that is, it becomes the element on the 
bottom layer of your picture. 

The preceding figure also shows the effect of the Put in back 
command. When the circle is put in back, it appears behind the 
rectangle. 

Make group Command 

This command puts all current elements into a group. You can then 
treat the group as a single element. 

First, make those elements you want included in the group current, 
either by Shift-clicking on them or by surrounding them with a "rubber 
rectangle." (See "Current Element" in Section 2 for instructions on 
selecting multiple elements.) Then, choose the Make group command 
from the Alignment Menu. A single extent appears, enclosing all 
elements in the group. 

When you make a group, GEM Draw Plus sees it as a new element and 
makes it the top, layer in your picture. 

Remember, any action you take on a group affects every element within 
it. For example, if a group contains three rectangles and you choose a 
new line width for the group, GEM Draw Plus changes the line width of 
all three rectangles. You can use the Break group command to break 
up the group, change the line width of the rectangles you want, and 
then remake the group afterward. 

Break group Command 

This command breaks up the current group and returns all elements in 
the group to their individual states. 

The group or groups you want to break up must be current when you 
choose the Break group command. 
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Align Commands 

The six alignment commands help you align current elements on 
specific boundaries. The following figure shows examples of how these 
commands work. In the examples, the text elements are current; the 
rectangle enclosing them is not. Element extents have been omitted for 
clarity. 

Align lefV 
LEFT 

CENTER 

RIGHT 

LEFT 

Align centev 
LEFT 

CENTER CENTER 

RIGHT RIGHT 

I 

Align righV 
LEFT 

CENTER 

RIGHT 
-"-

Align top-\ 
TOP MIDDLE BOTTOM 

vi 

TOP 

Align middle) MIDDLE TOP MIDDLE BOTTOM 

BOTTOM 

Align botto~ 
TOP MIDDLE BOTTOM 

Examples of Align Commands 
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Even spacing 

This command provides equal vertical spacing between all currently 
selected elements. 

When you choose the Even spacing command, the top and bottom 
current elements do not move, but GEM Draw Plus repositions all 
elements in between so that they are spaced equally. (The Even spacing 
command only moves these elements vertically; it does not move them 
horizontally.) 

Click on the pointer icon in your toolkit and then select the elements 
you want to space. 

TYPE MENU OPTIONS 

Point Sizes 

The pOint sizes determine the size (height and width) of characters in a 
text element. The higher the point size value, the larger the characters. 

In traditional typography, 72-point text is one-inch high, 36-point text 
one half-inch high, 18-point one-quarter inch high, and so forth. 
However, you cannot always predict text size accurately because 
printers, plotters, screens and cameras reproduce text differently. 

We recommend you experiment with the output devices you intend to 
use if text size is a critical factor in your pictures. You can create a 
picture that uses all of the different point sizes for each typeface and 
type style in the Type Menu. Reproduce the picture on each output 
device to determine exact text measurements. 

GEM Draw Plus can only display text in the point sizes listed in the Type 
Menu. Therefore, you cannot rescale text the way you can other 
elements; you can only change its point size. 

When you choose magnification factor 1 in the zoomer, GEM Draw Plus 
displays text elements in their correct proportional size. This is often the 
preferred view state when your pictures contain text elements. At other 
view states, text element sizes are only approximate. 
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Type Font Options 

The available type fonts are listed in the lower part of the Type Menu. 
What you see listed here depends on the following: 

• the type fonts available on your computer 

• the amount of RAM (Random Access Memory) installed in your 
computer 

Use GEMSETUP to install or remove fonts. GEMSETUP is provided with 
the GEM Desktop. If you do not have enough RAM, you may have to 
remove a font before installing another one. 

LINE MENU OPTIONS 

Line Style and Line Width Options 

You can choose various line styles or line widths from the Line Menu. 
Note, however, that wide lines can only be solid lines. 

To the right of the wide lines you see measurements, such as 1/32" or 
O.8mm, and so forth. They indicate the exact width of a line when you 
reproduce your picture on a printer, plotter, or camera. However, when 
you display your picture on a monitor screen, actual line widths vary 
depending on the monitor's resolution. 

The measurements you see for the wide lines might be in inch or . 
centimeter units depending on the paper size you specify with the Page 
size command (page 4-15). 
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End styles Command 

When you choose this command a dialog appears so you can specify 
how you want the ends of lines to look. Triangle markers indicate your 
current choice of line end styles in the dialog. See "Pointer" in Section 2 
to learn how to change your choices. 

Line end styles apply only to the following types of elements: 

• Lines 
• Sketches 
• Polygons 
• Arcs with no fill pattern 

PATTERN MENU OPTIONS 

With the exception of line and text elements, you can choose a pattern 
from the Pattern Menu for any element in your picture. 

The None and Shadow options are special cases. 

None 

This is the absence of a fill pattern. You can also think of it as a 
transparent pattern. 

Shadow 

This option produces a "drop-shadow" below and slightly to the left of 
the element, as pictured in the following examples. The precise location 
of the shadow is based on a percentage of the element's size. 

You can use Shadow in combination with any pattern. 

To remove a shadow, choose Shadow again while the element (or 
elements) is current. 
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Shadow Pattern 

COLOR MENU OPTIONS 

If your computer can display colors with GEM software, you see colors 
in the Color Menu; otherwise, the bars in the Color Menu are black. 

Color Codes 

In the Color Menu, each of the sixteen availa.ble colors is assigned a 
color code (0 through 15). You can use the color codes to assign colors 
to your picture's elements even if you are drawing the picture on a 
monochrome screen. 

When you reproduce a picture on a color output device, the device 
translates each code to a color it can create. Not all devices are able to 
produce sixteen colors; some, such as a camera, may be able to 
produce more. In short, colors are a function of the printer, plotter, 
screen, or camera you use to reproduce the picture and are not 
controlled by GEM Draw Plus. All devices translate color code zero as 
the background color. 
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Color Code 0 (Zero) 

If you make an element the same color as the background, the element 
blends into the background and seems to "disappear," although it is still 
there. Use this feature to achieve special effects, as shown below. 

Using Color Code Zero 

In the above figure, a rectangle with a solid black pattern was drawn 
first. Arcs were then drawn over each corner of the rectangle. The arcs 
were drawn with an opaque pattern and color code zero. 

Testing a Device's Color Capabilities 

To find out how a particular output device translates the sixteen color 
codes, create a picture similar to the one below. 

0 4 8 12 
1 5 9 13 
2 6 10 14 
3 7 11 15 

Color Test Picture 
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Note that the rectangles in the color test picture are numbered 0 
through 15. Assign the corresponding color code from the Color Menu 
to its associated rectangle. 

When you reproduce the color test picture on an output device, your 
results tell you how that particular device translates each color code. 

Where possible you should label each reproduction to show the device 
that created it. Store the reproductions for later reference. 

DRAW MENU COMMANDS 

Draw info Command 

The percentage shown in the dialog indicates how much "drawing 
space" you have available in the picture in your active window. The 
total amount of available space depends on: 

• the amount of RAM (Random Access Memory) installed in your 
computer 

• the number of picture elements used 

• the type of picture elements used 

• the complexity of the picture elements (for example, the number of 
sides in a polygon) 

End of Section 4 
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SECTION 5 

Picture Elements 

This section describes GEM Draw Plus picture elements. Also be sure to 
read "Elements" in Section 2 to learn about concepts that apply to all of 
the elements. 

The figure below shows the icons in the toolkit that you use to draw 
the elements. Each icon is labeled with its name and the page in this 
section where the element is described. The descriptions are arranged in 
this section alphabetically by element name. 

Sketch (page 5-9) ------,~ • -------..JCircle (page 5-4) 

Arc (page 5-2) --------1 .. ..II _------t'Polygon (page 5-6) 

Rounded Rectangle (page 5-8) ." _ine (page 5-5) 

Text (page 5-10) __ ~ectangle (page 5-7) 

Element Icons 
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Arc Element 

Arc Element 

GEM Draw Plus 

An arc is up to one-quarter of a circle or ellipse. 
It can be a curved line (with different line styles 
or line widths), or a solid pie section (with or 
without a pattern). A pie section is created if you 
have a pattern selected. To draw a curved line, 
go to the Pattern Menu and select "None." 

To draw an arc, select the Arc icon. The pointer changes to a cross hair 
when it enters the drawing surface. Drag the cross hair to form an arc. 
When the arc is the size and shape you want, release the mouse button. 

The initial movement of the cross hair (after pressing the mouse button) 
determines the shape of arc you draw. This is illustrated in the next 
figure. Start at any dot and follow the broken line to the connecting 
arrowhead to form the arc shown. 
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GEM Draw Plus Arc Element 

It may require a little practice to get the "feel" of drawing arcs the way 
you want them to appear. 

GEM Draw Plus draws arcs using: 

• the line style or line width marked in the Line Menu 
• the pattern marked in the Pattern Menu 
• the color marked in the Color Menu 
• the line end styles marked in the End styles dialog. (Note that the 

arrowhead line end style only applies if you draw a curved line arc 
using no pattern.) 

To form an arc that is larger than a quarter circle, combine multiple 
arcs. You can then form the arcs into a group using the Make group 
command. 

You can draw arcs most precisely with the Auto grid turned on. 
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Circle Element GEM Draw Plus 

Circle Element 

You can draw circles or ellipses using the circle 
element. 

To draw a circle or ellipse, click on the circle icon in the toolkit and 
move to the drawing surface. As you drag the cross hair, a "rubber 
circle" previews the size and shape of the circle. When the circle looks 
the way you want, release the mouse button. 

GEM Draw Plus draws circles and ellipses using: 

• the line style or line width marked in the Line Menu 
• the pattern marked in the Pattern Menu 
• the color marked in the Color Menu 

You can draw circles and ellipses most precisely with the Auto grid 
turned on. 
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GEM Draw Plus Line Element 

Line Element 

\ 
A line element is a single straight line connecting 
any two points on the drawing surface. 

To draw a line, select the line icon from the toolkit and move to the 
drawing surface. As you drag the cross hair, a "rubber band" line moves 
with the cross hair to preview your line. Release the mouse button 
when the line is the length and direction you want. 

GEM Draw Plus draws the line using: 

• the line style or width marked in the Line Menu 
• the line end styles marked in the End styles dialog 
• the color marked in the Color Menu 

Note: An area enclosed by these single line elements cannot be filled 
with a pattern. 
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Polygon Element GEM Draw Plus 

Polygon Element 

A polygon is a multi-sided element with straight 
sides. 

To draw a polygon, follow these steps: 

1. Select the polygon icon from the toolkit and move to part of the 
drawing surface where you want the polygon to begin. 

2. Click the mouse button and move the cross hair in any direction to 
form the first side of the polygon. 

3. When the first side of the polygon is the length and direction you 
want, click the mouse button again. 

4. To form the second and subsequent sides of the polygon, continue 
to move the cross hair and click the mouse button as you did for 
the first side. (lines can cross each other.) 

5. When the polygon is the size and shape you want, you can either (1) 
connect the polygon's end point to its starting point, or (2) double
click to signal you are finished. If you have not connected the end 
point to the starting point, the polygon will have an "open" side, that 
is, without a border. 

If you make a mistake when drawing the polygon, press the Backspace 
key to to de-select the incorrect points. Continue drawing when ready. 

GEM Draw Plus draws polygons using: 

• the line style or line width marked in the Line Menu 
• the pattern marked in the Pattern Menu 
• the color marked in the Color Menu 
• the line end styles marked in the End styles dialog 
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GEM Draw Plus Rectangle Element 

Rectangle Element 

A rectangle is a four-sided element with straight 
sides formed at gO-degree angles. A square is a 
rectangle. 

To draw a rectangle, select the rectangle icon from the toolkit and move 
to the drawing surface. As you drag the cross hair diagonally, a "rubber 
rectangle" previews the size and shape of the rectangle. When it is the 
size and shape you want, release the mouse button. 

GEM Draw Plus draws rectangles using: 

• the line style or line width marked in the Line Menu 
• the pattern marked in the Pattern Menu 
• the color marked in the Color Menu 
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Rounded Rectangle Element GEM Draw Plus 

Rounded Rectangle Element 

A rounded rectangle is a rectangular shape with 
rounded corners. 

To draw a rounded rectangle, select the rounded rectangle icon from 
the toolkit and move to the drawing surface. As you drag the cross hair 
diagonally, a "rubber rectangle" previews the size and shape of the 
rounded rectangle. When it is the size and shape you want, release the 
mouse button. 

GEM Draw Plus draws rounded rectangles using: 

• the line style or line width marked in the Line Menu 
• the pattern marked in the Pattern Menu 
• the color marked in the Color Menu 
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GEM Draw Plus Sketch Element 

Sketch Element 

Sketch is a free-form line. "Free-form" means 
the line can be straight, curved, angular, or any 
combination of these. Thus, drawing with the 
sketch element is like drawing with a pencil. 

To draw with sketch, select the sketch icon from the toolkit and move 
to the drawing surface. Drag in any direction to draw. When your 
sketch is complete, release the mouse button. 

When you draw with the sketch element, GEM Draw Plus plots each 
point in the line that deviates from a straight line. GEM Draw Plus can 
only plot a finite number of such points, so there is a limit on line 
length. The straighter the line, the longer it can be; conversely, the more 
crooked the line, the shorter it will be. However, you can connect 
several such lines by drawing them end-to-end, so this should not pose 
any serious limitations. If GEM Draw Plus stops sketching while you are 
drawing a line, simply start another line where that one left off. 

GEM Draw Plus draws sketches using: 

• the line style or line width marked in the Line Menu 
• the color marked in the Color Menu 
• the line end styles marked in the' End styles dialog 
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Text Element 

Text Element 

TEXT 

GEM Draw Plus 

You use the TEXT element to add text to your 
picture. Select a style, size, and type font for the 
text from the Type Menu. 

To add text, select the TEXT icon from the toolkit, move to the drawing 
surface, and click the mouse button where you want the text to begin. 
The text cursor (a vertical bar) appears beneath the cross hair. Type in 
your text with the keyboard. 

When you reach the end of a line, press Enter. The text cursor moves to 
the beginning of the next line. Add text on the current and subsequent 
lines by typing the characters and pressing Enter. 

Press Enter repeatedly to insert double, triple, or more spacing between 
lines. 

If you want to add more text at a different location on the drawing 
surface, move the cross hair to that location, click the mouse button, 
and proceed as described above. 

If you start typing at the keyboard without selecting the TEXT icon, GEM 
Draw Plus puts this text wherever the cross hair is located at the time. 
You can drag this text to a new location at any time. 

As you enter text, it appears in the type style, point size, and type font 
marked in the Type Menu and in the color marked in the Color Menu. 

If you make an error while typing, use the Backspace or Del key to erase 
characters, and then retype them. Use the Esc key to erase all 
characters in a line to the left of the cursor. 
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GEM Draw Plus Text Element 

As discussed under "Point Sizes" (page 4-23), you cannot rescale text 
the same way you do other elements. To change the scale of a selected 
text element, choose a different point size from the Type Menu. 

GEM Draw Plus does not place extents around text after you enter it. To 
display the extents for a text elem~nt (and thereby make the element or 
elements current), click on the pointer icon in the toolkit and then select 
the text element or elements. 

Editing Text Elements 

You can add or delete characters anywhere in an existing text element. 
Just follow these steps: 

1. Use the pointer to make the text element current. 

2. Click on the TEXT icon in the toolkit. 

3. Place the cross hair at the point in the text element where you want 
to make the change and click again. The text cursor appears at the 
location you select. 

4. If necessary, use the left- and right-arrow keys to move the cursor 
back and forth to the exact location you want. 

5. To insert characters, type them on the keyboard. 

6. Use the Del or Backspace key to delete individual characters. Use 
Esc to delete parts of lines or whole lines. 

End of Section 5 
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APPENDIX A 

Item Selector 
The Item Selector (shown below with its major components labeled) 
appears when you want to do either of the following: 

• save a picture on disk 
• recall a picture previously stored on disk 

You see the Item Selector when you choose the Open or Save as 
command from the File Menu and, under certain conditions, when you 
choose the Close command or click on the window's close box. 

Close 
Box 
, , 

Directory 
line 

Selection 
LOne 

,------------- -------------- ------~ 
, I TEM SElECTOR , . ! Directory: B:\PICTURES\*.GEM ______ _ 

L.HI *.GEM Selection: 11---". __ 

.. --l-..OLDPIX_._ ;'0 
AARDVARK.GEM 
BUBBLES_.GEM 
CARP_.GEM 
DESKPLAN.GEM 
DIMPLES_.GEM OK 
JOKER_.GEM 
KITES_.GEM ~. ~J 
KITES82_.GEM ~ ... ...... ·r .......................... • 

Folder 
Indicator 

Directory 
Window 

Item Selector 

A-l 



Directory Line GEM Draw Plus 

DIRECTORY LINE 

The directory line shows the directory path for the folders and pictures 
listed in the directory window. You can change the information on this 
line to do the following: 

• name a folder where you want to store a picture 

• name a folder from which you want to recall a picture 

To change the information on the directory line, place the pOinter 
anywhere on the line and click. The text cursor appears after the last 
character on the line. Press the Backspace key to erase individual 
characters or press the Esc key to erase the entire line. Type the name 
of the folder you want to use. 

Wildcard Character 

You can enter asterisks (*) or question marks (?) in the directory line as 
a "wildcard" characters. For example, B:\PICTURES\*.GEM means "all 
pictures of type GEM in a folder named PICTURES on disk drive B." The 
entry A:\GEMAPPS\*.T?? means "all items of a type whose extension 
begins with the letter T in a folder named GEMAPPS on drive A." 

After you enter the information on the directory line, click inside the 
directory window or press Enter to update the window with a list of 
pictures in that folder. 

Note: You can find more information about directory paths, folders, and 
wildcard characters in the GEM Desktop guide and in your operating 
system manuals. 
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GEM Draw Plus Directory Window 

SELECTION LINE 

You can use the selecti"on line to do the following: 

• type the name of a picture you want to save on disk 

• type the name of a picture you want to recall from disk 

See Appendix B for information about picture names and types. 

DIRECTORY WINDOW 

The directory window lists the folders and pictures in the directory path 
specified on the directory line. The window can only show nine folder 
and picture names at a time. Use the scroll bar, arrows, and slider to 
move up and down in the directory if it contains more than nine items. 

Note: Folder names (preceded by a diamond) always appear first in the 
directory window. 
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Close Box GEM Draw Plus 

SELECTING PICTURES 

You can use any of the following methods to select a picture from the 
directory window. 

• Double-click on the picture's name in the directory window. This is 
the fastest method. 

• Click on the picture's name in the directory window. GEM Draw Plus 
inserts the name in the Selection line. Click on the OK button or press 
Enter .. 

• Click on the Selection line. When the text cursor appears at the 
beginning of the line.' type the picture's name and then click on the 
OK button or press Enter. (The picture's name does not have to be 
visible in the directory window to use this method.) 

CLOSE BOX 

The directory window has a close box in the upper left corner. Click on 
the close box to move back to the previous folder in the current 
directory path. 

If you click on the close box when you are in the root (initial) directory 
of your disk, the directory window shows you the drive letters (A:, B:, C:, 
etc.) for the disk drives in your computer. You can change to another 
disk drive by clicking on its drive letter. You then see the contents of its 
root directory in the directory window. 

End of Appendix A 
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APPENDIXB 

Picture Names and Types 
This appendix explains the rules and concepts concerning GEM Draw 
Plus picture names and types. It also explains how GEM Draw Plus 
protects your work by creating "backups" of your pictures. 

PICTURE NAMES 

Your GEM Draw Plus guide refers to pictures you create as "pictures." 
Your GEM Desktop guide refers to them as "items" or "documents." 
Your operating system manuals may refer to them as "files." These 
terms all mean the same thing. 

You must name pictures you create with GEM Draw Plus when you want 
to store theOm on disk. Some rules apply for naming your pictures. 

Picture names can contain from one to eight characters, and picture 
types up to three, for example "MONALlSA.GEM." The characters can be 
any combination of numbers and letters, but most special characters 
{such as periods, question marks, brackets, etc.} and blank spaces are 
not acceptable. If you put spaces anywhere in a picture name, GEM 
Draw Plus automatically removes them. 

PICTURE TYPE 

GEM Draw Plus automatically appends a period {.} and the characters 
"GEM" to your picture name. These characters indicate the picture's 
"type." For example, if you name your picture POSTER, GEM Draw Plus 
saves the picture under the name POSTER.GEM. 

The picture type helps you and GEM Draw Plus distinguish pictures from 
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Backup Picture Protection GEM Draw Plus 

other items on your disks. For example, when you choose the Open 
command, GEM Draw Plus lists all pictures with a GEM type in the 
directory window of the Item Selector. You can select the picture you 
want to open from this list. 

Note: GEM Draw Plus only works with GEM type pictures. 

GEM TYPE DOCUMENTS AND OTHER GEM APPLICATIONS 

Many GEM applications create a GEM type document when you save an 
item on disk. (They're primarily for use with GEM OUTPUT.) In some 
cases (though not all), you can use these GEM type documents with 
GEM Draw Plus. See the guide for your particular GEM application to 
find out if this is possible. 

BACKUP PICTURE PROTECTION 

Every time you save a picture that has been saved before on disk, GEM 
Draw Plus retains the original version as a backup. The backup version 
has the same picture name, but GEM Draw Plus changes its type from 
GEM to BAK. 

For example, assume you created a picture and named it STllLiFE (which 
GEM Draw Plus stored under the name STllLlFE.GEM). You subsequently 
decide to make changes to the· picture and, after making your changes, 
use the Save command to update the disk. GEM Draw Plus does the 
following: 

• It stores the revised version of your picture under the name 
STllLlFE.GEM . 

• It retains your original picture on disk under the name STllLlFE.BAK. 

GEM Draw Plus can only access pictures having the GEM type. If you 
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GEM Draw Plus Backup Picture Protection 

want to use the BAK version of a picture with GEM Draw Plus, you must 
first change its type to GEM. You can do this from the GEM Desktop 
using the Info/Rename command on the File Menu. However, you must 
also change its picture name since two pictures of the same name 
cannot reside in the same folder. 

End of Appendix B 
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APPENDIXC 

Shortcuts 
Frequently-used GEM Draw Plus commands have shortcut methods, 
which you can read about in this appendix. While using GEM Draw Plus, 
choose the Shortcuts command from the Page Menu to see an on
screen summary of the shortcuts. 

PAGE SIZE COMMAND 

Double-click on the ruler icon to invoke the Page 
size command (see page 4-15). 

RULER SPACING COMMAND 

· . . . · . . . · . . . · . . . 
ZOOMER/PANNER 

Double-click on the grid icon to invoke the Ruler 
spacing command (see page 4-15). 

Double-click on a magnification state in the 
zoomer to automatically invoke the panner. This 
helps you quickly locate the area of your picture 
where you want to work. See pages 2-16 and 
2-17 for descriptions of the zoomer and panner. 
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KEYBOARD SHORTCUTS 

Many of the menu commands have a keyboard shortcut, that is, a way 
of entering that command by pressing a combination of keys instead of 
clicking in the menu. These key combinations usually involve holding 
down the Alt key or Ctrl key (shown on screen as the diamond and 
caret symbols) while pressing another. , 
For instance, Alt-D means hold down the Alt key and press the D key. 
That has the same effect as clicking on Delete in the Modify Menu. 
Holding Ctrl and pressing 0 is the same as clicking on the Open 
command to open a new picture. The exceptions are the Function Keys 
(Fl, F2, F4, and "F6). These keys are pressed by themselves. For 
instance, pressing Function key 6 (F6) displays the End Styles dialog in 
the Line Menu. 

Table C-l. File Menu 

Command Shortcut Meaning 

New Ctrk"W Create new picture 
Open Ctrl-O Open existing picture 

Close Ctrl-C Close active window 
Save Ctrl-V Save picture edits 
Save as Ctrl-M Save and name picture 
Abandon Ctrl-A Abandon changes made 

To Output Ctrl-U Send to printer, etc. 
Quit Ctrl-Q Leave GEM Draw Plus 
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Command 

Auto grid Off/On 

Page size 
Ruler spacing 

Shortcuts 
Save preferences 

Command 

Delete 
Undelete 

Make Copy 
Select all 

Rotate 
Flip horizontal 
Flips vertical 

Table C-2. Page Menu 

Shortcut 

Alt-G 

Function Key 2 
Function Key 4 

Function Key 1 
Alt-V 

Meaning 

Control Auto Grid 

Set page orientation 
Set ruler increments 

Display viewing aids 
Save GEM Draw Plus 
settings 

Table C-3. Modify Menu 

Shortcut Meaning 

Alt-D Erase selected element(s) 
Alt-U Restore erased element(s) 

Alt-C Reproduce element(s) 
Alt-S Make all elements current 

Alt-R Turn element 90 degrees 
Alt-Z Flip element left/right 
Alt-T Flip element top/bottom 
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Command 

Put in front 
Put in back 

Make group 
Break group 

Align left 
Align center 
Align right 
Align top 
Align middle 
Align bottom 

Page center 
Even spacing 

Command 

End styles 

Table C-4. Alignment Menu 

Shortcut Meaning 

Alt-F Element in foreground 
Alt-K Element in background 

Alt-M Group elements 
Alt-B Separate elements 

Alt-H Left column alignment 
Alt-I Center column alignment 
Alt-J Right column alignment 
Alt-Y Top row alignment 
Alt-L Center row alignment 
Alt-N Bottom row alignment 

Alt-P Center on page 
Alt-E Even vertical spacing 

Table C-S. Line Menu 

Shortcut Meaning 

Function Key 6 Set line end style 

Note: Keyboard shortcuts are not available when a GEM Desktop 
Accessory (for example, the Calculator) is on the screen. 

End of Appendix C 
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APPENDIX 0 

Using a Graphic Tablet with 
GEM Draw Plus 

To use a graphics tablet with GEM Desktop and GEM Draw Plus, you 
need the device drivers on your GEM Desktop disks. If your software is 
not set up to use a graphics tablet, run GEM Setup. 

Most graphics tablets operate on the principle of absolute coordinates. 
Therefore, unlike the mouse, when you lift the stylus and move it to a 
different location on the tablet, the screen pointer also moves to that 
location. 

See your graphics tablet manual for instructions on attaching it to your 
computer and learning its general operating principles. 

End of Appendix 0 
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